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Fast	drawing	for	everyone.	AutoDraw	pairs	machine	learning	with	drawings	from	talented	artists	to	help	you	draw	stuff	fast.	AutoDraw	requires	Javascript.	About	this	game	This	is	a	game	built	with	machine	learning.	You	draw,	and	a	neural	network	tries	to	guess	what	youre	drawing.	Of	course,	it	doesnt	always	work.	But	the	more	you	play	with	it,	the
more	it	will	learn.	So	far	we	have	trained	it	on	a	few	hundred	concepts,	and	we	hope	to	add	more	over	time.	We	made	this	as	an	example	of	how	you	can	use	machine	learning	in	fun	ways.	Watch	the	video	below	to	learn	about	how	it	works,	and	Built	by	Jonas	Jongejan,	Henry	Rowley,	Takashi	Kawashima,	Jongmin	Kim,	Nick	Fox-Gieg,	with	friends	at
Google	Creative	Lab	and	Data	Arts	Team.	2024-12-23	I've	split	up	"Eye	Gaze	Mode"	into	several	discrete	features:	Quick	Undo	Button:	Adds	a	floating	undo	button	that's	always	visible.	Enlarge	UI:	Enlarges	menus,	buttons,	and	windows.	Dwell	Clicker:	Automatically	clicks	by	hovering	over	controls	for	a	time.	Vertical	Color	Box:	Makes	the	Colors	box
tall	instead	of	wide.	(This	one	was	already	split	out.)	I've	also	added	a	brand-new	feature:	Head	Tracker:	Lets	you	move	the	cursor	with	your	head.	(See	demo	video	below!)	Quick	Undo	Button	Extras	>	Quick	Undo	Button	is	a	huge	advancement	for	usability	on	touchscreen	devices.	Making	mistakes	is	no	more	a	chore.	Just	tap,	tap,	tap	to	undo.	Easy
as	that.	Enlarge	UI	Extras	>	Enlarge	UI	increases	the	size	of	menus,	buttons,	and	windows.	Scaling	of	toolbars	and	menus	will	be	limited	to	the	available	space	on	the	screen,	making	it	more	useful	on	mobile	devices,	compared	to	the	basic	UI	scaling	that	existed	in	Eye	Gaze	Mode.	Dwell	Clicker	Extras	>	Dwell	Clicker	automatically	clicks	by	hovering.
It's	intended	for	use	with	an	eye	tracker	or	head	tracker	software	(and	optionally	specialized	hardware)	that	lets	you	move	the	mouse	without	using	your	hands.	This	was	the	core	feature	of	Eye	Gaze	Mode,	but	it	can	now	be	used	in	any	UI	configuration:	with	any	theme,	with	or	without	enlarged	UI,	with	a	horizontal	or	vertical	colors	box.	Head
Tracker	(All-New	Feature!)	Extras	>	Head	Tracker	mode	uses	your	webcam	to	track	your	head	movements	and	move	the	mouse	cursor	accordingly.	It's	powered	by	Tracky	Mouse.	I	recorded	a	short	demonstration	video,	drawing	the	TrackyMouse	logo	using	TrackyMouse:	Your	browser	does	not	support	the	video	tag.	I	made	sure	to	tilt	the	webcam
down	so	you	can	see	that	I'm	not	using	my	arms.	To	try	it	out:	Enable	Extras	>	Head	Tracker.	Click	Start	and	allow	access	to	your	camera.	Ensure	your	face	is	well	lit	and	centered	in	the	camera's	view.	Adjust	sensitivity	and	smoothness	settings	to	your	liking.	Move	your	head	to	move	the	red	dot	on	the	page,	which	acts	as	your	cursor,	and	hover	over
elements	to	click	them.	Tips:	You	can	pause	dwell	clicking	by	hovering	over	the	pause	button	()	in	the	bottom	left	corner.	When	hovering	over	a	window	title	bar,	or	using	certain	tools	on	the	canvas,	like	the	brush,	it	knows	to	hold	down	the	mouse	button	to	drag	or	draw.	The	next	dwell	will	release	instead	of	clicking.	If	you	minimize	the	Tracky	Mouse
window,	it	will	minimize	to	a	button	in	the	menu	bar,	which	you	can	click	to	restore	the	window.	If	you	close	the	window,	it	will	disable	the	feature.	Right	now	this	only	works	with	dwell	clicking,	and	automatically	enables	the	Dwell	Clicker,	but	in	the	future,	it	may	work	with	other	ways	of	clicking,	like	blinking	or	smiling.	You	can	also	download	the
Tracky	Mouse	desktop	app	to	control	your	whole	computer	with	your	head.	Discord	server	Animation	credit:	Wolfie-le-Wolf	Join	the	new	98.JS.org	Discord	server	to	discuss	these	features	and	share	your	JS	Paint	drawings!	Improved	About	window	I	managed	to	make	the	Help	>	About	Paint	window	much	more	compact	while	including	more
information.	See	a	visual	comparison	here.	You	can	switch	to	swipe	or	onion	skin	modes	and	move	the	slider	to	compare	before	and	after	images.	Here's	what's	new:	Reworded	everything	to	be	terser,	using	short	labels	instead	of	full	sentences.	()	Replaced	readme	link	with	a	link	to	the	homepage.	()	Added	a	link	to	the	Discord	server.	()	Made	sure	all
links	open	in	a	new	tab.	()	Made	it	use	a	bigger	app	icon	();	also	created	a	bigger	version	of	the	gay	pride	icon	variant	for	pride	month	()	Added	a	version	number	back	into	the	About	window	()	and	moved	it	to	a	new	line	()	Moved	the	update	check	status	indicator	beside	the	icon	()	Fixed	centering	of	the	About	window	on	small	screens	()	Misc.	Changes
I	updated	JS	Paint	within	98.js.org	recently,	although	it	might	not	have	the	latest	changes	yet.	If	an	image	is	dropped	on	the	Project	News	window,	it	will	no	longer	try	to	open	it	as	a	document.	It	was	easy	to	do	this	accidentally	by	idly	clicking	and	dragging	while	reading	the	news.	()	Fixed	checkbox	menu	items	showing	a	grid	of	small	checkmarks
instead	of	a	single	checkmark	in	the	Electron	app	with	Enlarge	UI	mode	enabled.	()	The	Dwell	Clicker	can	now	toggle	collapsed	details	in	error	dialogs.	()	Enabled	dragging	toolbars	with	the	mouse	in	Dwell	Clicker	(but	not	with	dwell	clicker	itself).	()	Fixed	the	titlebar	size	for	tool	windows	in	Enlarge	UI	mode.	()	All	themed	tool	icons	now	work	in
Enlarge	UI	mode.	(	+	+	)	I've	implemented	the	size	status	indicator	for	all	tools.	()	Fixed	missing	width/height	labels	in	Image	>	Attributes	dialog.	()	Fixed	default	file	name	when	saving	a	wallpaper	with	File	>	Set	As	Wallpaper	(Tiled/Centered).	()	Fixed	default	file	name	when	saving	selection	with	Edit	>	Copy	To,	and	an	error	that	occurred	with	Edit
>	Copy	To	in	the	Electron	app.	()	Fixed	ignoring	of	file	format	choice	when	saving	a	palette	with	Colors	>	Save	Colors	in	the	Electron	app	()	Fixed	error	handling	for	clipboard	access	()	Fixed	Shift+Insert,	Ctrl+Insert,	and	Ctrl+Delete	shortcuts	()	Improved	error	message	dialogs	for	Imgur	upload	failures	()	Added	a	Privacy	Policy	(tl;dr:	jspaint	doesn't
try	to	track	you,	unlike	most	of	the	internet)	()	Behind-the-Scenes	Changes	Updated	OS-GUI.js	from	~0.6.0	to	0.7.3	Made	use	of	OS-GUI's	new	AccessKeys	API	(	+	+	)	Now	using	proper	aria-keyshortcuts	values	to	tell	screen	reader	software	about	keyboard	shortcuts	()	Dwell	Clicker	is	now	powered	by	Tracky	Mouse.	()	Migrated	to	ESLint	v9	and	its
flat	config,	and	improved	code	uniformity.	(...)	Simplified	code	quality	checking	workflow	by	bundling	different	checks	into	one	script	(npm	run	lint)	()	Improved	handling	of	errors	with	no	stack	trace,	like	SyntaxError.	It	will	now	show	the	URL	and	line/column	numbers	for	errors	with	no	call	stack.	()	Fixed	an	error	that	occurred	when	embedded	in
98.js.org	due	to	looking	for	menus	inside	the	app	frame	when	they're	actually	outside	(	+	)	Marked	more	parts	of	the	JS	Paint	systemHooks	API	as	optional	()	Defined	TypeScript	types	for	the	JS	Paint	systemHooks	API	()	Worked	on	secret	features	which	should	be	really	fun	in	the	future.	Merry	Christmas!	2024-04-27	Introducing	the	Bubblegum
theme!	Office	software	has	never	looked	so	refined,	as	with	the	Bubblegum	theme's	elegant	Business	Pink	color	scheme.	All	the	icons	in	this	theme	were	AI-generated,	as	an	experiment.	Current	mainstream	AI	technology	really	struggles	at	creating	a	full	set	of	icons	in	one	go,	and	the	style	is	always	a	little	bit	different	from	image	to	image,	so	the
process	involved	generating	many,	many	images,	usually	prompting	it	to	create	an	"icon	set"	in	order	to	hopefully	get	a	few	icons	that	match,	to	add	to	the	overall	icon	set.	There's	very	little	control,	and	things	often	come	out	wonky	or	overly	generic,	but	overall	it	takes	very	little	effort,	so	it's	a	strange	thing.	Luckily,	I	could	get	away	with	some
stylistic	differences	between	the	abstract	shape	icons	and	the	more	detailed	tool	icons.	I	hand-edited	a	few	of	the	icons,	but	they're	mostly	as	they	came	out	of	the	AI.	My	favorite	is	the	Eye	Gaze	Mode	pause	button	icon	(),	which	I	got	for	free	randomly	due	to	the	AI	misinterpreting	"eye	dropper".	I	love	the	way	it	blends	seamlessly	into	the	button.	The
3D	bevels	are	also	AI-generated,	applied	with	copious	usage	of	9-slice	borders.	Try	The	New	Theme	On	the	Extras	menu,	click	Themes,	then	Bubblegum.	The	icons	aren't	optimized	for	legibility	at	small	sizes,	so	be	sure	to	try	it	out	together	with	Extras	>	Eye	Gaze	Mode,	or	else	increase	your	browser's	zoom	level,	by	scrolling	the	mouse	wheel	while
holding	Ctrl	or	,	for	the	full	effect.	Maintenance	In	other	news,	I've	been	investing	a	lot	into	making	JS	Paint	more	maintainable.	You	won't	see	these	changes	in	the	app	directly,	but	they	help	make	the	code	more	malleable,	like	adding	water	to	clay	to	shape	it	without	breaking	it.	Converted	the	codebase	almost	entirely	to	ES	Modules.	Made	remaining
usage	of	global	variables	explicit	in	each	file.	Split	up	some	huge	files	into	smaller	files.	Added	type	annotations	to	the	codebase,	using	JSDoc	comments.	This	way	errors	can	be	spotted	earlier,	and	editors	can	provide	better	autocompletion,	all	while	keeping	the	code	in	plain	JavaScript,	with	no	compile	step.	These	changes	will	make	it	easier	to	add
cool	new	features	to	JS	Paint	in	the	future.	2024-02-22	The	Modern	theme	has	been	renamed	Modern	Light	and	a	new	Modern	Dark	theme	has	been	added.	Modern	Light	before	(tool	icons	from	Windows	Vista):	Modern	Light	after	(custom	SVG	icons):	I	designed	a	custom	icon	set,	inspired	by	Windows	Vista's	icons.	I	also	customized	the	icons
significantly	for	the	Modern	Dark	theme,	to	improve	the	contrast	across	the	board.	Modern	Dark	before	(tool	icons	from	Windows	Vista,	with	aliasing	artifacts	when	viewed	against	a	dark	background):	Modern	Dark	after	(custom	SVG	icons):	When	adapting	the	Vista	icons	to	scalable	vector	graphics,	I	had	to	make	lots	of	subtle	design	decisions,	but
the	biggest	difference	you'll	notice	is	that	the	Brush	tool	matches	the	Classic	style	of	a	flat	tipped	brush	(albeit	with	added	gradients),	since	I	really	didn't	like	the	Vista	Brush	tool	icon.	I	mean	come	on,	it's	the	only	icon	that's	cut	off,	by	design!	And	it	just	looks	like	a	blob	to	me,	at	least	the	purple	version.	(There's	also	a	green	version.)	Besides,	a	wide
brush	emphasizes	the	distinction	from	the	Pencil	tool.	The	Classic	theme	has	been	renamed	Classic	Light,	and	the	Classic	Dark	theme	has	been	updated.	Classic	Light	(still	using	tool	icons	from	Windows	98):	Classic	Dark	before:	Classic	Dark	after:	I	wasn't	happy	with	the	Classic	Dark	theme's	icons,	especially	my	use	of	color;	it	felt	like	a	cheap	RGB
color	inversion,	even	though	I'm	sure	I	gave	it	some	more	thought	than	that.	I	also	wasn't	sure	how	to	achieve	good	contrast	with	the	pencil	tip	while	maintaining	a	consistent	skeuomorphic	style,	since	graphite	is	dark	just	like	the	background.	So	I've	redesigned	the	pencil	in	a	more	abstract	way	(all	white	including	the	tip),	and	I've	made	the	icons
monochrome.	I'm	actually	a	big	fan	of	color	in	icons,	as	I	think	it	helps	to	distinguish	them,	so	if	anyone	wants	to	try	their	hand	at	a	Classic	Dark	theme	with	colored	icons,	I'd	be	interested	to	see	it!	That	said,	monochrome	has	a	nice	elegance	to	it;	it's	less	attention	grabbing,	and	I'm	sure	some	people	will	always	prefer	it.	I	also	updated	the	Occult
theme.	I	changed	the	Fill	With	Color	tool	into	a	pouring	cauldron,	the	Pick	Color	tool	into	a	dagger,	and	the	Magnifier	into	an	eyeball.	Occult	before:	Occult	after:	(Still	needs	more	ideas.)	Check	out	the	themes	in	Extras	>	Themes!	File	Formats	These	changes	have	actually	been	around	since	2021,	but	I	didn't	get	around	to	finishing	a	news	post	about
them	until	now.	Still,	there's	some	good	changes	here,	so	it	bears	mentioning!	File	>	Save	As	now	asks	for	a	file	name	and	format.	PNG,	GIF,	and	BMP	are	supported,	including	indexed	color	BMPs.	See	the	Supported	File	Formats	table	for	details.	Tip:	Use	PNG	if	you	don't	have	a	specific	reason	to	use	another	format,	as	it	has	the	best	quality	when
saving.	Black	and	White	mode	in	Image	>	Attributes	is	generalized	to	handle	two	arbitrary	colors	(although	it's	still	called	"Black	and	White"	in	the	Attributes	window.)	If	an	image	has	only	two	colors,	when	switching	to	"Black	and	White"	mode,	it	automatically	adapts	to	these	colors	and	fills	the	Colors	box	with	appropriate	dither	patterns.	If	you	use
Image	>	Invert	in	Black	and	White	mode,	it	now	swaps	the	two	colors	present	in	the	image,	instead	of	converting	colors	to	their	RGB	opposites.	If	the	image	is	pure	black	and	white,	these	two	operations	are	equivalent,	but	now,	for	example,	a	green-and-black	image	will	become	a	black-and-green	image,	rather	than	pink-and-white.	Colors	>	Save
Colors	also	now	asks	for	a	file	name	and	format.	An	absurd	number	of	file	formats	are	supported.	You	can	even	export	CSS	variables	for	use	in	a	web	design	project.	RIFF	Palette	(*.pal)	is	compatible	with	MS	Paint,	and	GIMP	Palette	(*.gpl)	is	compatible	with	many	open	source	graphics	programs	such	as	Inkscape	and	Krita.	You	can	find	lots	of
palettes	to	use	on	Lospec.	Download	a	palette	as	GIMP	GPL	and	use	Colors	>	Get	Colors	to	select	the	file,	or	drag	and	drop	the	file	onto	JS	Paint	to	load	the	palette.	API	I	also	documented	a	first	version	of	the	API	for	JS	Paint.	I	have	not	yet	put	much	design	into	the	API;	rather,	I	have	just	documented	the	interface	I	came	up	with	for	my	own	use	in
98.js.org.	In	other	words,	this	is	more	of	a	draft	of	an	API,	though	I	will	certainly	create	a	changelog	when	I	decide	to	clean	it	up.	So	feel	free	to	start	using	it	if	you	don't	mind	updating	your	code	as	the	API	changes.	If	you	want	to	embed	JS	Paint	in	your	own	project,	you	can	take	a	look	at	the	Embed	in	your	website	section	of	the	readme.	Homepage	JS
Paint	now	has	a	homepage	at	jspaint.app/about.	I	designed	it	like	a	90s	website.	You	know,	one	of	those	thoughtless	background	pattern	filled	ones.	2022-07-28	JS	Paint	is	now	finally	open	source,	licensed	under	the	MIT	License.	The	project	has	been	source-available	from	the	beginning,	since	I	never	felt	the	need	to	obfuscate	or	hide	the	code,	but	it	is
now	legally	open	source.	I	look	forward	to	seeing	how	you	use	JS	Paint	in	your	own	projects!	There	is	not	yet	a	formal	API	for	JS	Paint,	but	if	you	want	to	get	in	on	the	cutting	edge,	you	can	take	a	look	at	how	98.js.org	embeds	JS	Paint.	Expect	the	API	to	change	significantly	in	the	future.	I've	been	meaning	to	open	source	JS	Paint	for	a	long	time.	There
are	some	legal	issues,	resources	I	don't	have	the	copyright	to,	but	I	think	they	should	generally	fall	under	fair	use.	And	I	have	created	beautiful	SVG	versions	of	the	icons,	so	it's	likely	possible	to	have	a	version	of	JS	Paint	without	any	directly	copyrighted	resources.	But	I've	finally	decided	to	stop	worrying	about	it,	and	just	open	source	it	already!	I	hope
you	enjoy	JS	Paint!	2021-12-08	View	>	Zoom	>	Show	Thumbnail	to	show	a	preview	of	the	image	at	a	small	size,	great	for	pixel	art.	Make	fine,	precise	edits,	while	keeping	it	all	in	perspective.	Pinch	zooming:	If	you	have	a	touch	screen,	use	two	fingers	to	zoom	in	and	out,	and	pan	the	view.	Alt+Mousewheel	to	zoom	in	and	out	quickly	on	desktop.	Unlike
the	Magnifier	tool,	this	allows	you	to	zoom	while	making	(or	moving)	a	selection,	for	added	precision.	Added	View	>	Fullscreen	to	toggle	fullscreen	mode.	This	is	nice	for	using	JS	Paint	on	your	phone.	The	Text	tool	now	automatically	expands	the	textbox	as	you	type.	When	resizing,	there's	now	a	minimum	size	based	on	the	text	in	the	textbox.	It
previews	exactly	what	size	it	will	end	up	with	when	resizing.	Docking:	If	you	drag	the	Colors	box	or	Tools	box	out	into	a	window,	you	can	now	dock	it	back	when	dragging	the	titlebar.	Previously	to	dock	it	you	had	to	double	click	the	titlebar,	or	drag	it	by	the	edge	of	the	window.	Menus	are	now	fully	keyboard	(and	screen	reader)	accessible.	In
particular,	you	can	hold	Alt	and	press	the	access	key	of	a	menu	button	to	open	the	menu,	and	then	(without	Alt)	press	the	access	key	of	a	menu	item	to	select	it.	The	access	key	of	an	item	is	the	underlined	letter,	or	the	first	letter	of	the	item's	text	if	there's	no	underline.	Error	details	are	now	hidden	by	default	in	error	dialogs.	The	details	may	be	more
overwhelming	than	useful	in	a	lot	of	cases,	but	if	you	need	them,	you	can	expand	the	details.	File	>	Exit	now	exits	to	the	official	web	desktop,	98.js.org,	a	re-creation	of	Windows	98,	full	of	games	and	applications.	This	project	spun	out	of	JS	Paint,	and	I	have	implemented	now	Sound	Recorder,	Notepad,	Calculator,	and	even	Windows	Explorer,	to	a	high
level	of	detail.	It	also	includes	projects	from	other	people,	other	recreations	of	old	programs,	like	Webamp,	a	meticulous	recreation	of	Winamp,	and	JS	Solitaire,	a	Solitaire	clone	(I	tweaked	it	for	accuracy,	adding	the	card	back	images,	etc.)	Pixel	Perfect	All	interface	elements	are	now	thematically	styled,	powered	by	OS-GUI.js	and	98.css.	The	whole
interface	is	now	pixel	perfect	accurate	to	Windows	98.	(Okay,	there's	a	few	things	that	are	a	pixel	off	or	so,	but	seriously,	I	lined	up	a	screenshot	and	got	it	essentially	perfect.)	Improved	layout	of	View	>	Zoom	>	Custom	Zoom	window,	matching	the	design	in	MS	Paint.	Added	padding	to	all	dialogs	so	they	don't	feel	cramped	anymore.	Message	boxes
now	include	warning	or	error	icons,	and	play	a	sound	when	they	appear.	Improved	View	>	View	Bitmap:	it	now	uses	the	theme's	wallpaper	background	color,	if	the	image	is	smaller	than	the	window.	It	now	closes	with	a	click	or	key	press,	and	doesn't	let	you	edit	the	image	(which	was	weird).	The	Help	window	can	now	be	minimized	to	the	bottom	of
the	screen,	even	though	there's	no	taskbar.	It	works	like	how	Windows	98	does	if	the	process	managing	the	taskbar	crashes.	Fixes	Menu	buttons	are	easier	to	open	on	a	touch	screen.	Sometimes	you	had	to	tap	twice	before	the	menu	opened.	Fixed	large	square	brush	continuity	(it	left	gaps	before,	due	to	a	half-implemented	optimization).	The	selection
and	textboxes	no	longer	"blow	up"	if	you	resize	them	to	a	minimal	size.	They	are	now	limited	when	you	drag	an	edge	past	the	opposite	edge.	Fixed	a	bug	where	vertically	thin	selections	were	difficult	or	impossible	to	drag	(despite	showing	a	drag	cursor).	(The	draggable	region	was	offset	outside	of	the	selection	box.)	Fixed	a	similar	bug	where	tool
previews	would	get	offset	if	the	canvas's	height	was	very	small.	Resize	handles	no	longer	get	smaller	when	the	object	to	resize	is	very	small.	The	draggable	region	for	handles	no	longer	gets	smaller	either,	except	in	dimensions	where	it	must.	It's	now	considerably	smarter	than	Windows	10	about	where	it	lets	you	drag	handles	from.	In	Image	>
Flip/Rotate,	you	can	now	click	the	custom	degrees	input	field	before	selecting	the	"Rotate	by	angle"	option.	The	magnifier	preview	and	other	tool	previews	are	now	hidden	while	dragging	the	Colors	box	or	Tools	box.	It	looked	confusing	when	the	magnifier	preview	was	shown	at	the	same	time	as	the	preview	outline	for	dragging/docking	a	tool	window.
For	languages	that	read	right-to-left,	the	History	view	(Edit	>	History)	now	uses	a	right-to-left	layout,	and	the	color	box	and	tool	box	no	longer	flip	their	layout	when	dragging	them	into	a	window	or	docking	them	back	to	a	side	of	the	application.	The	history	view	and	error	messages	use	more	localized	text.	Fixed	cut	off	icons	in	buttons	in	the	help
window	toolbar	in	the	Modern	theme.	All	windows	now	have	a	default-focused	control,	and	the	last	focused	control	in	the	window	is	remembered	for	when	you	refocus	the	window.	File	>	New	and	File	>	Open	now	create	a	new	autosave	session,	instead	of	using	the	current	session.	Winter	Theme	Updated	the	Winter	theme	with	advent	calendar-style
tool	buttons,	that	reveal	(improved)	holiday	pixel	art	for	each	tool	when	you	select	them.	This	means	that	the	Winter	theme	is	more	usable,	since	it	doesn't	obscure	the	functions	of	all	the	tools	with	pixel	art.	Also,	if	it	doesn't	feel	quite	enough	like	an	advent	calendar	for	you,	you	can	hold	Shift	to	select	multiple	tools	at	once.	Perhaps	you	could	make	a
drawing	using	only	one	tool	for	the	16	days	leading	up	to	Christmas,	with	exceptions	for	the	Pick	Color	and	Magnifier	tools,	of	course.	Snowflakes	in	the	menus	indicate	what	letter	you	can	press	to	select	that	item.	To	disable	the	Winter	theme,	click	the	Grinch	at	the	bottom	of	the	screen,	who	will	then	smile	a	nasty	smile	and	steal	Christmas	from	you.
You	can	get	it	back	with	Extras	>	Theme	>	Winter.	2020-12-20	JS	Paint	is	now	largely	localized	into	26	languages.	How	am	I	releasing	so	many	languages	at	the	initial	release	of	multi-lingual	support,	you	may	ask?	Well,	this	project	has	the	somewhat	unique	opportunity	to	reuse	localizations	from	an	existing	program,	since	it's	primarily	a	remake	of
MS	Paint.	I	downloaded	and	installed	26	versions	of	Windows	98	in	virtual	machines,	and	extracted	text	from	mspaint.exe	in	each	one	of	them,	using	a	set	of	scripts	that	I	wrote	to	to	help	me	automate	the	process.	To	change	the	language,	go	to	Extras	>	Language.	Your	preferred	language	may	already	be	detected,	if	specified	in	system	or	browser
settings.	For	Arabic	and	Hebrew,	right-to-left	layout	is	supported!	I	tried	my	hand	at	some	Arabic	calligraphy...	If	you	want	to	contribute	translations,	get	in	touch!	I	need	to	do	some	technical	work	to	set	up	for	community	translations	on	a	public	platform,	but	I'm	glad	people	have	already	expressed	interest	in	helping	translate!	(I	also	want	to	simplify
the	language	in	various	parts	of	the	UI	before	asking	people	to	translate	them.)	Eye	Gaze	Mode	Eye	Gaze	Mode	lets	you	control	JS	Paint	without	using	your	hands.	It's	intended	for	use	with	an	eye	tracker,	head	tracker,	or	other	coarse	input	scenario.	You	don't	need	a	thousand-dollar	eye	tracker	device	to	play	around	with	this,	just	a	webcam	and	some
free	software.	I	recommend	Enable	Viacam,	which	is	not	an	eye	gaze	tracker,	but	rather	a	general	video	movement	tracker	that	you	can	set	up	to	track	your	head	movement	(or	your	torso	or	hand	or	anything	else).	Eye	tracking	via	a	webcam	has	a	ways	to	go,	but	it's	also	pretty	amazing	in	its	own	right.	Try	GazePointer.	Eye	gaze	tracking	requires
significant	calibration,	and	if	the	calibration	is	off,	it's	hard	to	use	because	you	can't	look	where	you	want	to	look	to	interact	with	things.	This	is	why	I	recommend	head	tracking	(if	that's	an	option	for	you),	because	then	you	can	freely	look	around,	and	control	the	cursor	independently,	so	if	it	gets	offset,	you	can	just	tilt	your	head	a	bit.	Eye	Gaze	Mode
is	built	mainly	for	people	with	movement	disabilities	like	ALS	or	Cerebral	Palsy,	but	it	can	also	just	be	a	sort	of	magical	experience.	It	can	also	be	frustrating,	and	takes	some	practice	to	master.	A	good	place	to	start	is	coloring	line	art	using	just	the	Fill	tool	():	Find	coloring	pages	online,	and	copy	and	paste	them	into	JS	Paint.	You	can	convert	them	to
black	and	white	in	Image	>	Attributes,	and	then	switch	back	to	Colors.	(This	makes	it	work	better	with	the	Fill	tool.)	Enable	Eye	Gaze	Mode	with	Extras	>	Eye	Gaze	Mode	and	note	that	it	will	start	clicking	where	you	hover.	You	can	disable	this	dwell	clicking	with	the	eye	icon	in	the	bottom	of	the	screen.	Make	the	image	fill	the	screen	with	View	>
Zoom	>	Zoom	To	Window.	Bonus:	Since	I	implemented	a	vertical	color	box	for	Eye	Gaze	Mode,	I	decided	to	make	this	available	as	a	separate	option.	Access	with	Extras	>	Vertical	Color	Box.	Speech	Recognition	Using	only	your	voice,	you	can	switch	tools	and	colors,	pan	the	view,	click	on	buttons	on	the	screen	by	name,	and	use	most	menu	items.	You
can	even	say	"draw	a	cat	in	a	party	hat"	to	have	JS	Paint	try	to	sketch	a	cat	in	a	party	hat.	This	feature	pairs	well	with	Eye	Gaze	Mode	for	a	more	complete	hands	free	experience.	The	feature	is	only	available	on	Chrome,	and	only	understands	English.	Note	that	Chrome	sends	your	voice	to	Google	servers.	Access	with	Extras	>	Speech	Recognition.	If
this	option	is	grayed	out,	your	browser	is	not	supported.	JS	Paint	will	show	what	it	thinks	you	said	in	the	status	bar	at	the	bottom	of	the	screen.	There	are	many	synonyms	for	commands,	and	often	you	can	do	things	with	very	short	phrases	like	"Curve"	to	switch	to	the	Curve	tool.	If	it's	not	recognizing	your	voice	for	short	commands	like	"Curve"	or
"Cut",	you	may	want	to	try	longer	phrases	like	"Curve	tool"	or	"Cut	selection",	as	this	helps	it	distinguish	the	sound	as	speech,	rather	than	a	cough	for	instance.	Edit	Colors	Dialog	I	also	implemented	the	Edit	Colors	dialog.	Previously	this	used	the	native	system	color	picker,	and	didn't	work	for	some	people.	Access	with	Colors	>	Edit	Colors	or	double
click	a	color	in	the	palette	to	edit.	An	animation	morphing	between	JS	Paint	and	MS	Paint's	color	picking	dialog.	It's	pretty	close,	other	than	the	font.	Keyboard	shortcuts	are	supported	in	this	dialog,	and	for	mobile	devices	with	small	screens,	I	made	it	treat	adding	custom	colors	as	a	separate	screen.	Conclusion	JS	Paint	should	be	way	more	accessible
now.	And	futuristic.	Of	course	there's	always	more	that	could	be	done.	Eye	Gaze	Mode	could	use	brush	stroke	smoothing,	and	Speech	Recognition	could	use	Artificial	General	Intelligence.	I'd	love	to	see	people	using	JS	Paint,	especially	the	Eye	Gaze	Mode	and	Speech	Recognition,	so	if	you	record	a	video	of	using	JS	Paint,	please	send	it	to	me	through
this	form.	This	lets	me	know	what's	actually	important	to	people,	and	what's	confusing,	and	it	gives	me	motivation	to	work	on	new	features.	2019-12-20	A	new	UI	skin	is	available,	under	Extras	>	Themes	>	Winter,	featuring	winter	and	holiday	icons,	festive	fonts,	and	a	palette	with	seasonal	colors	and	peppermint	patterns.	Merry	Christmas	and	happy
Hanukkah!	Better	History	New:	Jump	to	any	point	in	the	document's	history,	forwards	or	backwards,	with	Edit	>	History	or	Ctrl+Shift+Y.	Click	on	Text	in	the	history	view	to	go	back	to	text	editing.	You	can	return	to	when	a	selection	existed.	Note:	these	states	are	skipped	over	with	normal	Undo	and	Redo,	so	you	need	to	use	the	History	window.
Branching	history:	if	you	undo,	and	then	make	changes,	you	can	get	back	to	everything.	Future	states	are	preserved.	Warning:	History	is	not	saved	with	the	autosave.	Document	history	will	be	lost	if	you	refresh	the	page,	or	close	the	tab,	or	if	the	tab	crashes,	or	if	you	close	or	restart	your	browser,	or	likely	if	you're	just	on	a	phone	and	the	mobile
browser	loses	focus.	Improved	Mobile	Support	New:	Use	two	fingers	to	pan	the	view.	I	recently	made	it	easier	to	grab	handles	for	resizing	things.	With	that,	combined	with	multitouch	panning,	JS	Paint	is	much	more	useable	on	a	phone.	Caveat:	It's	slow	on	some	devices,	and	parts	of	the	interface	are	still	too	small	for	touch.	2019-12-04	Handles	are
now	way	easier	to	drag,	with	extended	click	targets,	similar	to	Paint	from	Windows	7.	It's	not	unreasonable	to	use	with	a	touch	screen	now!	This	applies	to	selections,	textboxes,	and	the	main	canvas	handles.	Resizing	things	while	zoomed	in	is	finally	fixed!	The	Text	tool	now	perfectly	previews	the	pixels	that	will	be	placed	on	the	canvas.	What	you	see
is	what	you	get!	Also	it	retains	all	browser	editing	behavior,	like	spellcheck,	using	a	convoluted,	yet	elegant	overlaying	strategy.	(I	prototyped	this	here	and	here	if	you're	interested.)	With	the	fill-only	option	selected,	the	Polygon	tool	now	previews	with	inverted	lines,	like	MS	Paint	does.	(When	you	finish	the	polygon,	the	boundary	of	the	shape	matches
the	preview	exactly,	because	it	actually	does	draw	a	stroke,	just	the	same	color	as	the	fill.)	2019-10-26	New:	The	Magnifier	now	lets	you	zoom	to	a	specific	location,	showing	a	preview	of	the	new	viewport.	Also,	when	zooming	out	with	the	Magnifier,	or	changing	the	zoom	from	the	toolbar	or	menus,	the	top	left	corner	of	the	viewport	is	now	kept
anchored.	Also,	pasting	a	selection	will	now	go	to	the	top	left	of	the	viewport,	instead	of	the	entire	document.	2019-10-09	New:	The	Grid.	Zoom	to	4x+	and	use	View	>	Zoom	>	Show	Grid	or	Ctrl+G	to	enable.	This	works	with	browser	zoom	as	well	to	provide	crisp	gridlines	even	if	you	zoom	in	with	your	browser.	New:	View	>	Zoom	>	Custom	Zoom,
including	an	actually-custom	numerical	zoom	option,	unlike	MS	Paint.	New:	Dynamic	cursors	for	brush	and	eraser,	so	you	now	have	a	preview	of	exactly	where	the	tool	will	draw.	Also,	in	the	event	that	your	browser	clears	canvases	to	free	up	memory,	you	should	be	more	likely	to	be	able	to	undo	to	get	back	to	a	useful	state.	2019-09-21	JS	Paint	now
lets	you	copy	real	image	data	to	the	Clipboard,	both	with	keyboard	shortcuts	and	from	the	Edit	menu.	This	feature	is	available	in	Chrome	76+.	Other	browsers	don't	support	it	yet,	as	of	Sep	2019.	Also:	paste	the	URL	of	an	image,	and	JS	Paint	will	load	and	paste	the	image.	(This	is	an	alternative	to	File	>	Load	from	URL,	which	replaces	the	document.)
Bring	your	storage	to	our	online	tool,	or	save	locally	with	the	desktop	app.	Describe	your	diagram:	No	login	or	registration	required.Diagram	generation	uses	OpenAI.	Draw.Chat	allows	you	to	create	boards	and	invite	participants	to	them.	In	Draw.Chat	you	can	draw	over	images,	PDF	documents	and	maps.	You	will	share	images,	watch	videos
together,	hold	teleconferences,	and	even	play	simple	paper	games	such	as	charades	or	tic-tac-toe.	Draw.Chat	provides	access	to	group	visual	communication	in	real	time.	Draw.Chat	is	a	chat	board	as	well	as	audio/video	chats,	direct	file	transfer	and	even	an	AL	assistant.In	Draw.Chat,	there	is	no	need	to	create	an	account.	The	boards	you	visit	are
saved	in	your	browser	history	and	in	the	sketchbook	tab.	You	can	freely	view	and	delete	boards.	You	can	give	your	boards	titles	and	descriptions,	so	you	can	organize	your	boards	and	make	them	easier	to	find.	Boards	are	stored	for	a	minimum	of	30	days,	and	can	be	accessed	through	unique	links.Draw.Chat	is	a	collaborative	note-taking	tool	for	team
members	or	teachers	looking	for	a	platform	that	multiple	participants	can	access.	Draw.Chat	allows	all	participants	to	collaborate	on	the	same	canvas	at	the	same	time.	All	you	need	to	do	is	send	the	generated	link	to	the	selected	people.	Selected	team	members	will	be	able	to	participate	in	drawing	and	chatting.Anything	can	be	a	background.	For
example,	a	photo	of	an	assignment	from	your	notebook,	on	which	you	annotate.	You	can	use	another	web	page,	a	map	or	a	PDF	document	as	a	background,	on	which	you	write	an	annotation	or	apply	a	handwritten	signature.Enrich	your	lesson	by	collaborating	with	artificial	intelligence.	The	AL	assistant	can	participate	in	a	group	chat,	and	when
providing	answers,	be	aware	of	the	chat	participants,	the	chat	history	and	the	location	indicated	on	the	map	by	the	questioner.	When	available,	simply	ask	the	question	directly	by	starting	the	statement	with	"@ai,"	such	as	"@ai,	evaluate	the	answers	given."Draw.Chat	provides	a	large	base	of	tools,	such	as	highlighters,	crayons	and	nibs.	Draw.Chat
responds	to	the	pressure	and	angle	of	the	stylus,	making	it	possible	to	work	with	graphics	tablets	to	create	natural	and	unique	drawings.	Working	with	Draw.Chat	resembles	working	with	traditional	paper	developing	additional	capabilities.	If	you	make	a	mistake,	you	can	easily	undo	the	last	move	or	erase	a	section	using	the	eraser.The	image	sharing
functionallows	you	to	combine	multiple	documents	into	a	board	of	any	number	of	pages.	You	can	combine	multiple	images	into	one	board,	annotate	it,	and	then	export	the	whole	thing	as	a	single	PDF	file.	You	can	also	share	the	created	boards	online	using	the	link.You	can	customize	Draw.Chat	using	the	prepared	configurator.	It	will	make	it	easier	to
prepare	your	classes	in	advance.	You	can	keep	Draw.Chat	boards	on	your	device	or	place	them	as	a	link	on	any	website.	You	can	also	use	Draw.Chat	using	the	ready	API.You	can	upload	PDF	documents,	JPG,	PNG,	SVG,	GIF	and	WebP	images	to	the	boards.	Shared	files	are	stored	for	30	days,	and	can	be	accessed	through	a	unique	link	consisting	of	the
conrol	sum	of	the	file	content.	You	can	transfer	larger	files	without	restrictions	directly	in	chat	between	online	participants.Uploaded	files	are	deleted	automatically	after	30	days	after	the	last	opening.	You	can	keep	files	by	visiting	your	board	and	reviewing	their	pages	at	least	once	every	30	days.	You	can	also	agree	to	delete	files	manually	by	clicking
on	the	"Delete	files"	button.Subscribe	to	our	newsletterYes.	Draw.Chat	is	a	free	online	whiteboard	for	drawing,	sketching,	and	collaboration.	You	can	start	a	board	and	invite	others	without	any	registration.Can	I	draw	on	PDFs	and	images	online?Yes.	You	can	upload	PDF	documents	or	images	and	draw	directly	on	them	in	real	time	together	with
others.Do	I	need	to	create	an	account	to	use	Draw.Chat?No	account	or	sign-up	is	required.	Just	open	a	board,	share	the	link,	and	start	drawing	online	instantly.Can	multiple	people	draw	at	the	same	time?Yes.	Draw.Chat	supports	real-time	collaboration,	so	many	participants	can	draw,	chat,	and	interact	simultaneously	on	the	same	board.Does
Draw.Chat	work	on	mobile	and	tablets?Yes.	Draw.Chat	works	in	the	browser	on	desktop,	mobile,	and	tablet	devices.	It	also	supports	stylus	input	for	natural	drawing.Is	my	data	stored	permanently?Boards	are	temporary	by	default.	Uploaded	files	and	drawings	are	stored	only	as	long	as	needed	and	may	be	removed	after	a	period	of	inactivity.Can	I	use
Draw.Chat	as	a	free	online	whiteboard	for	teaching?Yes.	Teachers	and	students	can	collaborate	in	real	time	on	the	same	board.	Its	free	to	use	and	works	directly	in	the	browser	without	any	login.	Start	painting	Sketch.	Paint.	Enjoy.	KRESKA.art	is	a	free	drawing	and	painting	app	that	runs	seamlessly	in	any	browser.	It	features	a	simple,	clean	interface,
a	proprietary	painting	engine,	and	a	large	collection	of	brushes,	allowing	your	art	to	be	truly	unique	and	amazing,	just	like	you.	Your	painting	almost	draws	itself.	Tracing	with	auto-color	is	magical!	Joy	of	creating	art.	KRESKA.art	elevates	painting	from	reference	to	a	whole	new	level.	Tracing	is	made	simple	with	a	dedicated	button	to	quickly	display
your	reference.	You	can	easily	adjust	the	reference	image	opacity	at	any	time	using	a	slider.	Additionally,	it	enhances	color	picking.	Set	your	brush	to	automatically	pick	colors	and	instantly	transfer	reference	image	colors	to	your	drawing.	Unclutter	your	screen.	Access	your	reference	with	a	single	tap.	Quickly	peek	at	your	reference.	A	dedicated
button	instantly	previews	your	reference	image.	Pressing	the	"peek"	button	displays	your	reference	on	top	of	your	drawing	with	full	opacity,	releasing	the	button	returns	you	to	your	drawing.	This	button	also	features	a	hidden	function:	pressing	and	moving	towards	the	image	activates	a	color	picker,	allowing	you	to	quickly	select	colors	from	your
reference	image.	You	also	have	traditional	preview	panel	available	if	you	like	your	reference	to	be	present	on	your	screen	all	the	time.	Reshape	and	refine	with	the	Liquify	brush.	Push,	stretch,	and	warp	without	losing	a	single	detail.	Transform	expressions,	shapes,	and	proportions	in	seconds	while	your	lines	stay	crisp	and	your	colors	stay	clean.	From
subtle	adjustments	to	bold	exaggerations,	the	Liquify	tool	keeps	your	style	intact.	Cat	drawing	reshaped	with	the	Liquify	brush,	from	cute	to	wide-eyed	adorable.	KRESKA.art	supports	some	of	the	most	popular	gestures:	two-finger	tap	to	undo,	three-finger	tap	to	redo,	four-finger	tap	to	hide	or	show	the	interface,	one-finger	press	and	hold	to	open	the
color	picker,	pinch	and	rotate	with	two	fingers	to	zoom	or	rotate	your	canvas.	KRESKA.art	works	on	PC,	Mac,	and	Linux,	as	well	as	on	Android	and	iOS,	both	desktop	and	mobile,	in	Google	Chrome,	Apple	Safari,	Microsoft	Edge,	Mozilla	Firefox,	Opera,	Brave,	or	any	other	modern	browser.	Bring	Your	Creativity	to	the	Real	World	Why	KRESKA's	AR
Feature	Stands	Out	Most	AR	(Augmented	Reality)	drawing	apps	only	let	you	project	images	onto	your	camera	feed,	limiting	you	to	basic	tracing.	KRESKA.art	goes	beyond	that	by	allowing	you	to	use	the	live	camera	feed	as	your	background,	giving	you	a	real-time	preview	of	how	your	artwork	will	look	in	the	real	world.	You	can	trace	over	a	static	image
or	draw	live	with	full	access	to	KRESKA's	tools.	Read	more	With	KRESKA's	AR	feature,	your	creativity	is	no	longer	limited	to	simple	projections.	You	can	interact	with	your	surroundings	in	real	time	and	see	exactly	how	your	ideas	translate	into	reality.	Design	tattoos	with	confidence	by	pointing	your	camera	at	your	skin	and	previewing	the	perfect	fit
before	making	it	permanent.	Experiment	with	makeup	using	your	laptop's	camera	to	test	colors	and	styles	before	applying	them.	Plan	murals	or	graffiti	by	sketching	directly	onto	a	live	camera	feed	of	a	wall,	adjusting	your	design	as	needed.	The	possibilities	go	even	further.	You	can	create	patterns	on	clothing,	map	out	decorations	on	furniture,	or
sketch	blueprints	onto	real	surfaces.	Whether	you	are	an	artist,	designer,	or	hobbyist,	KRESKA	gives	you	the	power	to	bring	your	ideas	to	life	with	unmatched	flexibility	and	precision.	To	start	tracing	a	reference	image	onto	paper	using	KRESKA.art,	follow	these	steps:	Load	your	reference	image	in	the	app.	Open	the	"Drawing	Options"	menu	and
select	"AR	camera	background".	Click	to	allow	the	app	to	use	your	camera.	(No	image	or	data	is	ever	sent	to	KRESKA.art	servers;	everything	runs	locally	in	your	browser.)	The	"AR	camera	background"	button	works	as	a	toggle:	Press	once	to	turn	the	camera	on.	Press	again	to	switch	between	zoom	levels.	Press	again	to	turn	the	camera	off.	Place	your
phone	or	tablet	on	an	elevated	surface	(e.g.,	a	box	of	napkins	or	a	tall	glass)	so	you	can	see	the	paper	through	your	screen.	Adjust	the	reference	image	opacity	to	around	50%	for	better	visibility.	Use	the	"Threshold	filter"	or	"Make	light	pixels	transparent"	options	in	the	"Reference	Image	Options"	menu	to	make	the	reference	image	stand	out.	Now	you
can	trace	by	making	physical	marks	on	the	paper	while	looking	at	your	screen,	with	your	hand	and	pencil	underneath.	KRESKA.art	is	fully	web-based,	with	optimized	code	to	ensure	fast	loading	and	smooth	performance.	Since	it	runs	directly	in	your	browser,	there's	no	need	for	any	installation,	just	open	the	app	and	start	creating	instantly.	I	usually
pasted	my	references	on	one	side	of	the	canvas	and	drew	on	the	other	side.	Now	the	entire	canvas	is	free	and	the	reference	image	is	available	at	the	press	of	a	button.	KRESKA.art	has	proprietary	painting	engine	that	was	built	from	scratch.	Without	compromises	I	was	polishing	it	until	it	was	perfect.	Drawing	experience	is	anything	you	ever
encountered,	fluid,	responsive,	satisfying,	simply	unique.	KRESKA.art	supports	layers	with	basic	features	like	adding,	deleting,	merging,	duplicating,	fast	clearing,	and	controlling	layer	opacity.	You	can	also	enable	alpha	lock	to	paint	only	on	the	opaque	portions	of	the	layer,	which	are	the	areas	that	were	painted	before.	Choose	from	an	ever-growing
collection	of	over	100	beautiful	handmade	brushes.	The	selection	includes	basic	round	brushes,	soft	airbrushes,	sketching	brushes	resembling	real	pencils,	inking	brushes,	watercolor	brushes,	charcoal	brushes,	pixel	brushes,	and	more.	Each	brush	can	be	used	for	painting,	erasing,	blending,	and	with	the	auto-color	feature.	Many	of	the	brushes
recognize	the	direction	of	your	digital	pen	strokes	for	maximum	realism.	There	are	many	ways	for	picking	color,	press	and	hold	with	one	finger,	click	the	eyedropper	icon	from	the	color	window	or	the	floating	toolkit	or	use	the	keyboard	shortcut	"i".	To	quickly	pick	color	from	your	reference	image	press	the	big	"peek"	button	on	the	vertical	bar	and
move	towards	the	center	of	the	screen	or	press	"p"	and	move	you	pencil.	Each	brush	can	paint	with	your	reference	image	colors	applied	automatically	which	feels	magical.	KRESKA.art	supports	all	types	of	input:	pen,	touch,	and	even	mouse.	All	brushes	support	pressure	sensitivity,	which	you	can	turn	on	or	off	for	a	given	brush	to	control	brush	size	or
brush	opacity.	Many	brushes	also	support	pen	direction	and	tilting,	a	feature	available	on	the	iPad	with	Apple	Pencil	or	on	professional	graphics	tablets	like	Wacom	or	Huion.	KRESKA.art	supports	many	keyboard	shortcuts,	some	commonly	used	like	"ctrl+z"	to	undo	"space"	to	move	the	canvas	around,	some	are	unique	like	the	peek	"p"	button	to
quickly	peek	at	your	reference	image.	Most	of	the	shortcuts	are	shown	on	the	"Floating	toolkit	panel",	select	"Toggle	toolkit	float"	from	the	menu.	If	you	want	your	reference	image	always	available	next	to	your	painting	you	can	use	the	preview	panel.	Select	"Toggle	preview	panel"	from	the	menu.	This	panel	has	some	unique	features,	it	can	mimic	the
movement	of	our	painting	on	the	screen.	Tolls	float	(sometimes	called	touch	docker)	can	help	you	access	all	the	application	features	even	without	keyboard	or	on	devices	without	touch	support	Create	beautiful	pixel	art	using	various	pixel	brushes.	Combine	them	with	reference	image	and	auto-color	feature	to	create	stunning	pixel	art	with	ease.	You
can	utilize	the	lasso	tool	to	define	a	specific	area	for	painting,	ensuring	your	brush	stays	inside	the	selection.	This	makes	it	easy	to	create	both	hard	and	soft	edges.	KRESKA.art	saves	your	work	automatically	in	browsers	storage	and	will	restore	your	drawing	even	if	you	reload	the	page	PS	In	addition	to	the	proprietary	.kreska	file	format,	you	can	also
save	your	work	in	the	.psd	format,	allowing	you	to	open	it	in	Adobe	Photoshop	or	other	applications	compatible	with	.PSD	files.	KRESKA.art	itself	can	also	open	basic	.PSD	files.	Chose	between	two	color	modes,	dark	theme	and	light	theme,	it	will	be	hard	for	you	to	decide	as	both	are	beautiful	API	The	simple	URL	API	in	KRESKA.art	enables	you	to
create	links	that	automatically	load	images	from	the	internet	directly	into	the	app.	For	website	owners,	this	means	your	visitors	can	use	the	images	you	host	as	drawing	references	within	KRESKA.art.	This	feature	is	especially	valuable	for	creators	of	drawing	tutorials,	as	it	allows	students	to	seamlessly	draw	on	or	reference	tutorial	images	directly	in
the	app.Find	more	in	the	"API	for	your	website"	section.	Toggle	between	various	Symmetry,	Perspective,	and	Drawing	Guide	modes.	The	vertical,	horizontal,	or	quadrant	symmetry	tool	will	mirror	your	strokes	across	multiple	planes.	Perspective	guides	help	you	draw	shapes	from	one-point,	two-point,	or	three-point	perspectives.	Additionally,	a	2D	grid
and	an	isometric	grid	are	available	to	help	you	position	your	strokes	accurately.	AR	Transform	your	screen	into	an	interactive	projector!	The	AR	Drawing	feature	allows	you	to	use	your	device's	camera	as	a	live	background,	making	it	effortless	to	trace	digital	images	onto	physical	surfaces.	Simply	load	a	reference	image,	align	it	with	your	workspace,
and	start	sketching	with	precision.	Whether	you're	sketching	on	paper	or	another	medium,	this	tool	enhances	accuracy	and	creativity	like	never	before!	The	liquify	feature	allows	you	to	push	pixels	around	on	the	canvas.	It	is	ideal	for	reshaping	objects,	adjusting	proportions,	or	refining	details	in	a	smooth	and	natural	way.	With	this	powerful	tool,	you
can	correct	your	lines	without	erasing	and	redrawing	them,	giving	you	flexible	control	while	preserving	the	original	colors	and	textures.	If	you	use	KRESKA.art	in	Safari	browser	on	your	iOS	device	and	also	own	Procreate,	you	can	easily	transfer	your	KRESKA.art	creations	to	Procreate.	Simply	click	"Share	image"	from	the	"File	options"	menu	and
select	Procreate	from	the	list	of	available	applications.	The	image	will	be	saved	directly	to	your	Procreate	library.	I	promise	that	KRESKA.art	will	always	remain	100%	free	of	AI	features.	I	believe	in	empowering	human	creativity,	not	replacing	it	with	algorithms.	While	others	may	rush	to	automate	art,	I	am	committed	to	preserving	the	authenticity	and
fulfillment	that	comes	from	true	creative	expression.	Here,	your	ideas,	your	skills,	and	your	vision	are	what	truly	matter.	This	is	a	space	where	real	artists	thrive,	and	where	creativity	remains	100%	human.	0.	KRESKA.art	logo	(click	to	hide	top	menu)	1.	Menu	panel	2.	Layers	panel	3.	Colors	panel	Brush	selection	4.	Painting	brush	(click	twice	to	select
brush	for	painting)	5.	Eraser	(click	twice	to	select	brush	for	erasing)	6.	Blending	brush	(click	twice	to	select	brush	for	blending)	Brush	settings	7.	Brush	size	control	toggle	(change	size	with	pressure)	8.	Brush	opacity	control	toggle	(change	opacity	with	pressure)	9.	Auto	color	picker	toggle	(brush	will	pick	color	from	the	reference	image	automatically)
Tools	and	actions	section	10.	Lasso	tool	(paint	within	selected	area)	11.	Values	check	(press	to	change	your	painting	to	grayscale)	12.	Reference	image	placement	(move	the	reference	image	above	or	underneath	your	painting,	use	button	18	to	change	opacity)	13.	Guides	toggle	(toggle	between	symmetry,	perspective	and	grid	guidelines)	14.	Mirror
your	painting	(flips	your	painting	vertically)	15.	Clear	layer	(deletes	content	of	selected	layer)	Left	vertical	bar	16.	Brush	size	slider	17.	Brush	opacity	slider	18.	Peek	reference	image	(preview	your	reference	image	while	you	press	the	button)	19.	Reference	image	opacity	(most	useful	when	the	image	is	on	top	-	use	button	12)	20.	Undo	button	21.	Redo
button	Floating	panels	22.	Main	panel	to	toggle	between	menu,	layers,	color	panel	and	brushes	23.	Additional	reference	image	preview	window	24.	Floating	tools	panel	to	access	every	tool	on	devices	where	touch	gestures	are	not	supported	(like	tap,	pinch,	rotate)	Yes,	KRESKA.art	is	free	with	no	limits	and	no	ads,	one	thing	you	need	to	remember	is
that	you	can	only	work	on	one	painting	at	a	time	because	of	the	browser's	limitations,	if	you	want	to	work	on	a	different	painting	without	loosing	your	current	work	then	save	the	current	work	to	".kreska"	file,	go	to	the	MENU	then	click	"Save	layers	to	.kreska	file",	or	use	a	different	browser,	not	a	different	browser	tab	but	a	different	browser	brand
like	Google	Chrome	and	Microsoft	Edge,	because	KRESKA.art	keeps	your	work	in	browser's	database	in	one	place.	On	an	existing	canvas:	Open	the	menu	panel,	click	"Load	reference	image",	select	the	image,	once	loaded	you	can	adjust	the	size	and	rotate	the	image,	click	the	brush	icon	on	top	to	return	to	the	main	application	screen	and	start
painting.	While	creating	new	canvas:	Open	the	menu	panel,	click	"New	drawing"	choose	one	of	the	four	options	in	the	"From	File/Camera"	section	for	example	"Resize	canvas	to	match	full	photo	size",	select	the	image,	once	loaded	you	can	adjust	the	size	and	rotate	the	image,	click	the	brush	icon	on	top	to	return	to	the	main	application	screen	and
start	painting.	If	you	just	want	an	image	to	use	online	or	save	to	your	gallery,	click	the	hamburger	menu	icon	and	select	"Save	image",	this	will	create	a	PNG	format	image.	If	you	are	on	mobile,	you	can	also	tap	the	"Share	drawing"	button,	which	will	also	create	a	PNG	image	and	give	you	sharing	options.	PNG	is	a	flat	image	format,	so	if	you	want	to
keep	your	layers	to	continue	editing	later,	choose	to	save	the	layers	as	a	.kreska	or	.psd	file,	which	you	can	load	in	Kreska	again,	but	that	is	not	an	image	it	is	a	source	file.	Only	the	PNG	allows	you	to	use	it	online	or	save	it	to	your	gallery.	Open	the	menu	panel,	click	"File	info"	Change	the	desired	color	on	the	color	tab,	open	the	menu	panel,	click
"Active	color	as	background"	in	the	Drawing	options	section.	Clicking	the	button	again	will	reset	the	background	color	to	white.	To	make	the	background	transparent	click	"Transparent	background"	in	the	Drawing	options	section.	Clicking	the	button	again	will	reset	the	background	color	to	white.	The	following	shortcuts	are	supported	"t"	-	Show
floating	Tools	panel	"w"	-	Show	reference	image	preview	Window	"h"	or	"u"	-	hide/show	user	interface	","	and	"."	-	change	reference	image	opacity	"p"	-	peek	at	the	reference	image	"f"	-	reference	image	placement	(move	the	reference	image	above	or	underneath	your	painting,	use	button	","	or	"."	to	change	opacity)	"a"	-	toggle	auto-color	picking
(reference	image	is	required)	"1"	-	Open	menu	panel	"2"	-	Open	layers	panel	"3"	-	Open	color	panel	"d"	-	switch	to	painting	brush	"e"	-	switch	to	eraser	"b"	-	switch	to	blending	brush	"s"	-	toggle	size	change	with	pressure	"o"	-	toggle	opacity	change	with	pressure	"l"	-	lasso	tool	"v"	-	values	check	(press	to	change	your	painting	to	grayscale)	"i"	-
eyedropper	tool	"["	and	"]"	or	"x"	-	change	brush	size	(pressing	"x"	and	moving	the	pointer	up	or	down	changes	the	brush	size	faster)	"m"	-	mirror	your	painting	(flips	your	painting	vertically)	"z"	-	zoom/scale	the	canvas	view	"r"	-	rotate	the	canvas	view	"space"	-	move	the	canvas	around	";"	and	"''	-	change	pan	opacity	"g"	-	guides	toggle	(symmetry,
perspective,	grid	guidelines)	"ctrl+z"	-	undo	"del"	-	clear	current	layer	"ctrl+y"	-	redo	"ctrl+v"	-	paste	image	from	clipboard	(this	will	not	work	on	images	copied	from	websites),	copy	an	image	from	your	local	folders	or	press	Ctrl++s	(Ctrl	key	+	Windows	key	+	s	key	pressed	together)	to	select	and	copy	images	from	websites.	KRESKA.art	has	several
quick	gestures	and	shortcuts	available:	Interface	-	Click	the	KRESKA.art	logo	icon	to	hide/show	the	top	bar.	-	The	interface	will	be	hidden	automatically	if	you	move	your	line	towards	the	interface	while	drawing.	-	When	you	deliberately	hide	the	interface	using	the	menu,	the	toolkit	panel,	or	a	three-finger	tap,	you	can	restore	it	by	clicking	one	of	the
top	corners	of	the	screen	or	tapping	with	three	fingers	again.	Setting	color	-	You	can	manually	set	the	HEX	color	code	by	clicking	the	top	color	preview	area	with	the	larger	HEX	code	text	in	the	color	tab/panel.	-	Click	the	bottom	color	preview	area	with	the	smaller	HEX	code	text	from	the	color	tab/panel	to	change	the	color	back	to	the	last	used	one.
Picking	color	-	To	quickly	pick	a	color	directly	from	the	reference	image,	click	and	hold	the	"Peek"	button,	then	drag	your	pointer	towards	the	image	(if	a	reference	image	is	available).	-	To	quickly	pick	a	color	from	the	visible	canvas,	press	and	hold	on	the	screen	with	one	finger	(or	click	and	hold	with	the	mouse).	This	feature	can	be	disabled	in	the
settings	("Long	press	picker")	to	avoid	accidental	color	picking,	especially	when	the	application	is	used	by	children.	Using	paint	bucket	-	To	quickly	initiate	the	paint	bucket,	click	and	hold	the	color	palette	icon	in	the	top	menu,	then	drag	your	pointer	towards	the	painting.	Switching	brushes	-	Tap	and	hold	the	paint/erase/blend	icon	in	the	top	bar	to
change	the	paint/erase/blend	brush	to	the	current	brush.	Selecting	brushes	-	In	the	brushes	tab/panel	(not	the	top	menu),	clicking	the	paint/erase/blend	icon	twice	will	collapse	all	the	categories,	allowing	you	to	find	a	brush	category	name	faster.	Changing	Brush	Size	-	To	quickly	change	the	brush	size,	click	"x"	and	move	the	pointer	up	or	down.	-
Other	ways	to	change	the	brush	size	include	using	the	brush	size	slider,	the	"["	and	"]"	keyboard	shortcuts,	or	setting	the	size	value	after	selecting	"Active	brush	size"	from	the	"Brush	Options"	menu.	Area	Selection	with	the	Magic	Wand	Tool	-	The	Magic	Wand	selection	tool	is	activated	by	dragging	the	Lasso	tool	onto	the	canvas.	Adjust	the	"Paint
Bucket/Magic	Wand	Threshold"	and	"Paint	Bucket/Magic	Wand	Grow	Size"	settings	in	the	menu	to	achieve	the	desired	result.	Finger	gestures	-	Two-finger	tap	to	undo.	-	Three-finger	tap	to	redo.	-	Four-finger	tap	to	hide	or	show	the	interface.	-	One-finger	press	and	hold	to	open	the	color	picker.	-	Pinch	and	rotate	with	two	fingers	to	zoom	or	rotate
your	canvas.	Toolkit	float	panel	-	When	using	the	toolkit	panel,	tap	the	center	of	the	panel	twice	(the	six	dots	icon)	to	reset	the	canvas	position,	rotation,	and	scale	to	default	values.	-	Tap	the	scale	icon	twice	to	reset	the	scale	to	100%.	-	Tap	the	rotate	icon	twice	to	reset	the	rotation	to	0	degrees.	-	Tap	the	pan	(hand)	icon	twice	to	center	the	canvas
without	changing	its	size	or	rotation.	-	While	rotating	using	the	rotate	icon,	the	canvas	will	rotate	around	the	screen's	center.	To	adjust	the	rotation	degree,	make	a	circular	gesture	around	the	center	of	the	toolkit	panel	(marked	by	the	six	dots	icon).	Sliders	-	Moving	away	from	the	slider	while	using	it	slows	down	its	movement.	If	the	application	is	not
responding	and	you	are	worried	about	losing	your	drawing,	please	do	not	close	the	application.	Instead,	visit	this	page:	On	that	page,	you	may	still	find	your	application's	layers	and	image	history.	Download	any	images	you	need,	and	you	can	later	import	them	as	layers	in	the	application.	If	the	main	application	is	completely	broken	and	does	not	work
even	after	reloading,	close	the	application	and	open	this	page:	On	that	page,	click	the	button	at	the	bottom	labeled	"Reset	/	Clear	Browser	Storage."	Please	note	that	this	will	reset	everything,	including	brush	settings,	and	will	also	clear	your	saved	layers.	The	long	press	color	picker	can	be	disabled	by	switching	the	"Long	press	picker"	toggle	to	off.
You	can	find	this	toggle	in	the	main	menu	under	the	"Drawing	options"	section.	No,	KRESKA	stores	all	your	work	locally	on	your	device	using	a	browser	storage	system	called	IndexedDB.	This	storage	contains	your	layers,	history,	menu	settings,	and	brush	settings.	Keep	in	mind	that	if	you	clear	your	browser	storage	or	the	kreska.art	storage	on
purpose,	you	will	lose	any	unsaved	work.	It	is	always	a	good	idea	to	save	your	work	to	a	file	before	closing	the	browser,	just	in	case.	To	summarize,	all	your	drawings	are	private	and	only	visible	to	you	in	the	browser	on	the	device	where	you	created	them.	Your	drawings	are	not	sent	anywhere,	and	no	one	can	see	or	use	them	unless	you	choose	to
publish	them.	If	you	want	your	art	to	be	seen,	feel	free	to	share	it	with	others.	The	best	place	to	share	your	work	is	with	our	KRESKA.art	community	on	Reddit:	KRESKA.art	is	developed	by	a	single	person	with	passion	for	art	and	programming.	This	app	is	offered	to	you	for	free,	but	your	support	can	make	a	world	of	difference.	If	you	enjoy	using
KRESKA.art	and	have	money,	your	contribution	will	help	cover	server	costs	and	ensure	the	ongoing	development	of	new	features.	There	are	so	many	exciting	ideas	I	can't	wait	to	bring	to	life,	and	your	support	can	make	that	possible.	If	you	aren't	able	to	contribute	financially,	you	can	still	make	a	huge	impact	by	sharing	this	app	with	others.	Thank
you!	Stay	updated	with	new	features,	tutorials,	and	community	artwork.Join	the	conversation,	share	your	creations,	and	help	shape	KRESKA.art.	Follow	us	today!	Choose	a	drawing	tool	from	the	toolbar.	The	Pencil	tool	is	great	for	freehand	drawing.	Select	your	desired	color	and	brush	size	before	you	start	drawing.	Use	"Save	Project"	to	store	your
drawing	in	your	browser's	local	storage.	Use	to	download	your	artwork	as	an	image	file	(PNG,	JPG)	or	as	PDF.	Use	the	shape	tools	to	add	rectangles,	circles,	and	lines	to	your	drawing.	The	Text	tool	allows	you	to	add	text	to	your	canvas.	All	elements	(shapes,	text,	drawings)	are	fully	editable.	Use	the	Selection	tool	to	move	,	resize,	rotate,	or	modify	any
element.	Drag	the	handles	to	resize	or	use	the	rotation	control.	Use	the	Undo	button	to	remove	the	last	element	you	created,	and	Redo	to	bring	it	back.	This	works	for	all	tools	including	drawing,	shapes,	and	text.	Create	elements	with	shape,	text,	then	switch	to	Select	mode	to	move,	resize,	and	edit	them.	You	can	also	add	images	(JPG,GIF,PNG,SVG)
to	your	canvas,	making	it	easy	to	create	magical	compositions,	all	fully	editable.	Loading
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